Systemic seismic vulnerability assessment software user’s manual

SYNER-G Reference Report 7

Editors: David Schäfer and Anna Bosi
Reviewer: Ahmet Yakut
Publishing Editors: Fabio Taucer and Ufuk Hancilar

2013
DELIVERABLE INFORMATION

Deliverable Title: 

D8.13 – Systemic seismic vulnerability assessment: Software user’s manual

Date of issue: 31 March 2012

Work Package: WP8 – Guidelines, recommendations and dissemination

Deliverable/Task Leader: Joint Research Centre

Editors: David Schäfer and Anna Bosi (VCE)

Reviewer: Ahmet Yakut (METU)

REVISION: Final
The SYNER-G Consortium

Aristotle University of Thessaloniki (Co-ordinator) (AUTH)

Vienna Consulting Engineers (VCE)

Bureau de Recherches Geologiques et Minieres (BRGM)

European Commission – Joint Research Centre (JRC)

Norwegian Geotechnical Institute (NGI)

University of Pavia (UPAV)

University of Roma “La Sapienza” (UROMA)

Middle East Technical University (METU)

Analysis and Monitoring of Environmental Risks (AMRA)

University of Karlsruhe (KIT-U)

University of Patras (UPAT)

Willis Group Holdings (WILLIS)

Mid-America Earthquake Center, University of Illinois (UILLINOIS)

Kobe University (UKOBE)
Foreword

SYNER-G is a European collaborative research project funded by European Commission (Seventh Framework Program, Theme 6: Environment) under Grant Agreement no. 244061. The primary purpose of SYNER-G is to develop an integrated methodology for the systemic seismic vulnerability and risk analysis of buildings, transportation and utility networks and critical facilities, considering for the interactions between different components and systems. The whole methodology is implemented in an open source software tool and is validated in selected case studies. The research consortium relies on the active participation of twelve entities from Europe, one from USA and one from Japan. The consortium includes partners from the consulting and the insurance industry.

SYNER-G developed an innovative methodological framework for the assessment of physical as well as socio-economic seismic vulnerability and risk at the urban/regional level. The built environment is modelled according to a detailed taxonomy, grouped into the following categories: buildings, transportation and utility networks, and critical facilities. Each category may have several types of components and systems. The framework encompasses in an integrated fashion all aspects in the chain, from hazard to the vulnerability assessment of components and systems and to the socio-economic impacts of an earthquake, accounting for all relevant uncertainties within an efficient quantitative simulation scheme, and modelling interactions between the multiple component systems.

The methodology and software tools are validated in selected sites and systems in urban and regional scale: city of Thessaloniki (Greece), city of Vienna (Austria), harbour of Thessaloniki, gas system of L'Aquila in Italy, electric power network, roadway network and hospital facility again in Italy.

The scope of the present series of Reference Reports is to document the methods, procedures, tools and applications that have been developed in SYNER-G. The reports are intended to researchers, professionals, stakeholders as well as representatives from civil protection, insurance and industry areas involved in seismic risk assessment and management.

Prof. Kyriazis Pitilakis
Aristotle University of Thessaloniki, Greece
Project Coordinator of SYNER-G

Fabio Taucer and Ufuk Hancilar
Joint Research Centre
Publishing Editors of the SYNER-G Reference Reports
Abstract

This report should work as a first guideline for using the EQvis – Platform. It shows the user the most used features of the package and guides the user through a tutorial which explains many of the features in EQvis. This document can only serve as a starting point. Many of the analyses need special datasets that have to be prepared first. This Tutorial comes with a sample dataset for the city of Vienna with which the user can get through the analyses produced in this project. More information together with the open source software code and the dataset for this Tutorial can be downloaded at the Syner-G website: www.syner-g.eu

Keywords: Tutorial, User Manual, EQvis. Platform, Software
Acknowledgments

The research leading to these results has received funding from the European Community's Seventh Framework Programme [FP7/2007-2013] under grant agreement n° 244061
Deliverable Contributors

VCE  David Schäfer
     Anna Bosi
     Thomas Gruber
     Helmut Wenzel

KIT  Bijan Khazai

UROMA Paolo Franchin
     Francesco Cavallieri
# Table of Contents

The SYNER-G Consortium ........................................................................................................... ii

Foreword .................................................................................................................................... i

Abstract .................................................................................................................................... iii

Acknowledgments .................................................................................................................... v

Deliverable Contributors ........................................................................................................ vii

Table of Contents..................................................................................................................... ix

List of Figures ........................................................................................................................ xiii

List of Tables ........................................................................................................................ xvii

1 Introduction............................................................................................................................... 1

1.1 ABOUT EQVIS ................................................................................................................... 1

1.1.1 Methodology .................................................................................................................. 2

1.1.2 IT-Details ....................................................................................................................... 2

1.2 USING THE MANUAL ..................................................................................................... 3

2 Installation............................................................................................................................... 5

2.1 SYSTEM REQUIREMENTS ............................................................................................. 5

2.2 INSTALLATION PROCESS ............................................................................................ 5

2.2.1 Installation from DVD ................................................................................................... 5

2.2.2 Network installation ...................................................................................................... 5

2.2.3 Installing Updates and New Modules ........................................................................... 6

3 Introductory example.............................................................................................................. 7

3.1 WELCOME SCREEN ....................................................................................................... 7

3.2 NEW SCENARIO ............................................................................................................... 8

3.3 ADDING DATA TO THE SCENARIO .............................................................................. 11

3.3.1 Adding the City Plan of Vienna ................................................................................... 11

3.3.2 Adding the Building Dataset ........................................................................................ 14

3.4 EXECUTE ANALYSIS .................................................................................................... 21

3.4.1 Analysis 1: Create Scenario Earthquake ................................................................. 21

3.4.2 Analysis 2: Building Structural Damage ................................................................. 25

3.5 VIEW THE RESULTS ..................................................................................................... 38

3.5.1 Table view ................................................................................................................... 38

3.5.2 3D Damage Bars .......................................................................................................... 39
3.6 FILTERING DATA ........................................................................................................... 41
3.7 PRINTOUT REPORTS ...................................................................................................... 42
3.8 LOG FILE ...................................................................................................................... 44

4 User Interface .................................................................................................................. 45

4.1 OVERVIEW .................................................................................................................... 45
4.2 TERMINOLOGY .............................................................................................................. 45
  4.2.1 Scenario View ........................................................................................................ 45
  4.2.2 Visualization View ................................................................................................ 46
  4.2.3 Data Catalogue ........................................................................................................ 46
  4.2.4 Style Editor View .................................................................................................. 46
  4.2.5 Table View ........................................................................................................... 46
  4.2.6 Reports View ......................................................................................................... 46
  4.2.7 Fragility View ...................................................................................................... 47
  4.2.8 Status Bar ............................................................................................................. 48
4.3 SPECIAL FUNCTIONS ................................................................................................... 48
  4.3.1 Managing the layers of the map ........................................................................... 48
  4.3.2 Improving the visualization ............................................................................... 48
  4.3.3 Saved Analysis Workflows ................................................................................ 48
  4.3.4 Filtering ............................................................................................................... 49

5 Using the OOFIMS – Plug-in ............................................................................................. 51
5.1 USING OOFIMS: EXAMPLE DATASET IN VIENNA ...................................................... 51
  5.1.1 Download/Unzip the data .................................................................................. 51
  5.1.2 Ingesting the datasets ....................................................................................... 51
  5.1.3 Starting the Analysis ......................................................................................... 52
  5.1.4 The OOFIMS Input mask .................................................................................. 52
  5.1.5 Running the analysis ......................................................................................... 53
  5.1.6 Read the output of OOFIMS ............................................................................. 53
  5.1.7 Creating the Intersections ................................................................................. 54
  5.1.8 Creating the MCDA Sub City Districts file ...................................................... 54

6 Using the MCDA – Plug-in ............................................................................................... 55
6.1 INTRODUCTION ............................................................................................................. 55
  6.1.1 OVERVIEW of MCDA SOFTWARE ..................................................................... 55
  6.1.2 Overview of MCDA Framework ...................................................................... 55
  6.1.3 Definition of Terms used in MCDA ................................................................. 56
6.2 INSTALLING THE MCDA TOOL ................................................................. 56
  6.2.1 Basic requirements for installing MCDA Tool ................................................. 56
  6.2.2 Quick step by step guide for installing MCDA ............................................. 57
  6.2.3 Links to OOFIMS outputs (i.e. visualization of simulations) ......................... 57
  6.2.4 Using the input interface in the SYNER-G Platform to launch MCDA .......... 59

6.3 MCDA SOFTWARE TUTORIAL ............................................................... 60
  6.3.1 SHELTER NEEDS MODEL .............................................................. 60
  6.3.2 Steps in developing the model ................................................................. 61
  6.3.3 Implementing the model in MCDA software .............................................. 62
  6.3.4 Displaying Results .............................................................................. 66
List of Figures

Fig. 1.1 Interactive surface of EQvis ................................................................. 1
Fig. 3.1 Welcome screen ............................................................................... 7
Fig. 3.2 Working environment ..................................................................... 8
Fig. 3.3 New scenario ................................................................................. 8
Fig. 3.4 Create scenario ............................................................................. 9
Fig. 3.5 Region of interest ......................................................................... 9
Fig. 3.6 Region of interest 2 ....................................................................... 10
Fig. 3.7 Default parameter ......................................................................... 10
Fig. 3.8 Working environment ................................................................... 10
Fig. 3.9 Ingest data ..................................................................................... 11
Fig. 3.10 File type ....................................................................................... 11
Fig. 3.11 Browse ........................................................................................ 12
Fig. 3.12 Ingest a new Shapefile ................................................................. 12
Fig. 3.13 Select data type ........................................................................... 12
Fig. 3.14 Set attributes mappings ............................................................... 12
Fig. 3.15 Set extra field information ............................................................. 13
Fig. 3.16 Descriptive data ........................................................................... 13
Fig. 3.17 Ingesting ....................................................................................... 13
Fig. 3.18 Working environment ................................................................ 14
Fig. 3.19 Ingest Dataset ............................................................................ 14
Fig. 3.20 Select file type ............................................................................ 15
Fig. 3.21 Browse ......................................................................................... 15
Fig. 3.22 Select data type ........................................................................... 16
Fig. 3.23 Set attribute mappings ................................................................. 16
Fig. 3.24 Set extra field information ............................................................. 17
Fig. 3.25 Descriptive data ........................................................................... 18
Fig. 3.26 Display the data on the map ......................................................... 18
Fig. 3.27 Change layer style ...................................................................... 19
Fig. 3.28 Adjusting parameters ................................................................. 19
Fig. 3.29 Visualization view ...................................................................... 20
Fig. 3.30 From 2-D to 3-D render ............................................................... 20
Fig. 3.31 3-D render ................................................................. 21
Fig. 3.32 Execute analysis .......................................................... 21
Fig. 3.33 Scenario selection ...................................................... 22
Fig. 3.34 Create scenario earthquake ......................................... 22
Fig. 3.35 Create scenario earthquake (advanced) ..................... 22
Fig. 3.36 Filling the form .......................................................... 23
Fig. 3.37 Select epicentre position ............................................ 24
Fig. 3.38 View results ............................................................. 24
Fig. 3.39 Syner-G mapper .......................................................... 25
Fig. 3.40 Import fragilities ....................................................... 25
Fig. 3.41 Create mapping .......................................................... 26
Fig. 3.42 Ingest the fragilities ................................................... 26
Fig. 3.43 Select file type: fragility ............................................ 27
Fig. 3.44 Browse ................................................................. 27
Fig. 3.45 Ingest a Fragility File ............................................... 27
Fig. 3.46 Select data type .......................................................... 28
Fig. 3.47 Set attributes mapping ............................................. 28
Fig. 3.48 Set extra field information ......................................... 29
Fig. 3.49 Descriptive data .......................................................... 29
Fig. 3.50 Ingest Dataset ............................................................. 30
Fig. 3.51 Select file type ............................................................. 30
Fig. 3.52 Browse ................................................................. 30
Fig. 3.53 Ingest a Fragility File ............................................... 31
Fig. 3.54 Select data type .......................................................... 31
Fig. 3.55 Set attribute mappings ............................................. 32
Fig. 3.56 Set extra field information ......................................... 33
Fig. 3.57 Descriptive data .......................................................... 34
Fig. 3.58 Building Structural Damage ...................................... 34
Fig. 3.59 Select a scenario ....................................................... 34
Fig. 3.60 Building Structural Damage ...................................... 35
Fig. 3.61 Search for Dataset .................................................... 35
Fig. 3.62 Search for Dataset (EQ Vienna) .................................. 36
Fig. 3.63 Search for Dataset (Building fragility) ...................... 36
Fig. 3.64 Import fragility mapping ............................................ 37
Fig. 3.65 Import damage ratios ................................................................. 37
Fig. 3.66 Execute .................................................................................. 38
Fig. 3.67 View results ......................................................................... 39
Fig. 3.68 Setting 3-D damage bars ...................................................... 40
Fig. 3.69 3-D damage bars ................................................................. 41
Fig. 3.70 Filtering data ......................................................................... 41
Fig. 3.71 Filtering data ......................................................................... 42
Fig. 3.72 Printout reports ..................................................................... 43
Fig. 3.73 Generated Pdf ...................................................................... 43
Fig. 4.1 Overview ................................................................................. 45
Fig. 4.2 Fragility set ............................................................................ 47
Fig. 4.3 Fragility curve ......................................................................... 47
Fig. 4.4 Layers ..................................................................................... 48
Fig. 4.5 Saved analysis workflows ..................................................... 48
Fig. 6.1 The Analysis “Read OOFIMS Output” (left), sample Dataset (right) ............... 57
Fig. 6.2 The Analysis “Create Intersections” (left), sample Dataset (right) ...................... 58
Fig. 6.3 Explanation about the computation of the Intersections ......................... 59
Fig. 6.4 The Analysis “Create MCDA SCDS” (left), sample Dataset (right) ................. 59
Fig. 6.5 The Analysis “MCDA Input” (left), starting screen of MCDA (right) ............... 60
Fig. 6.6 Decision criteria for computing Shelter Needs Index (SNI) ......................... 61
Fig. 6.7 Hierarchical Decision Criteria of Shelter Needs Model developed in MCDA using the “Tree View” ................................................................. 63
Fig. 6.8 Hierarchical Data Matrix in MCDA which can be used to enter, and edit the raw and normalized value of each of the criteria measures ...................... 63
Fig. 6.9 The Criterion Value Function Dialogue Box which can be used to define the shape of the normalization curve of each selected criteria measure .................. 64
Fig. 6.10 The criteria aggregator dialogue box, which can be used to define the aggregation relationship for each criteria as "weighted sum", "weighted product" or a "mathematical expression/formula" defined by the user ........................................ 65
Fig. 6.11 The interactive importance/weight dialogue box which can be used to change the weights of each of the criteria measures on the fly .................................... 66
Fig. 6.12 The stacked bar ranking for SNI displayed up to tier 1 .................................. 67
Fig. 6.13 Sorted stacked bar ranking of SNI displayed up to tier 2 .............................. 67
Fig. 6.14 Cob-web chart showing the distribution of the criteria weights for all of SNI measures at one glance ................................................................. 68
Fig. 6.15 Pie charts showing each the product of the weights and values for all of the alternatives ......................................................................................... 68
Fig. 6.16 A sensitivity graph in MCDA showing the sensitivity of the alternative's ranking to the weights of DPI. .............................. 69
List of Tables

Table 5.1 Input values for the OOFIMS Tutorial – “Analysis”…………………………………….. 53
Table 5.2 Input values for the OOFIMS Tutorial – “Buildings”…………………………………….. 53
1 Introduction

In the Project Syner-G the development of a prototype software for end user was a very important goal. One objective was to implement the methodologies developed in the various other work packages into the software package.

1.1 ABOUT EQVIS

EQvis is an advanced seismic loss assessment, and risk management software which stands on the Consequence-based Risk Management (CRM) methodology. CRM provides the philosophical and practical bond between the cause and effect of the disastrous event and mitigation options.

![Interactive surface of EQvis](image)

Fig. 1.1 Interactive surface of EQvis

It enables policy-makers and decision-makers to ultimately develop risk reduction strategies and implement mitigation actions (D.Schäfer, M. Pietsch, H. Wenzel 2013). In EQvis, a wide range of user-defined parameters are introduced. The breadth of user-defined parameters enables emergency planners to model a virtually unlimited number of scenarios (Achs, G. et al. 2010)
EQvis is based on the open-source-platform MAEviz, developed by the Mid-America Earthquake (MAE) Center and the National Center for Supercomputing Applications (NCSA) (MAEviz, Mid-America Earthquake Center. 2009).

It has an open-source framework which employs the advanced workflow tools to provide a flexible and modular path. It can run over 50 analyses ranging from direct seismic impact assessment to the modelling of socioeconomic implications. It provides 2D and 3D mapped visualizations of source and result data and it provides tables, charts, graphs and printable reports for result data. It is designed to be quickly and easily extensible.

1.1.1 Methodology

EQvis implements Consequence-Based Risk Management (CRM) using a visual, menu-driven system to generate damage estimates from scientific and engineering principles and data. It can also estimate impacts on transportation networks, social or economic systems (Duenas-Osorio, L.A. 2005, Kim, Y.S., Spencer, B.F., Song, J., Elnashai, A.S., Stokes, T. 2007).

It requires the following as inputs: hazard, inventory and fragility models (Flesch, R. 1993, Genctürk, B., Elnashai, A. S., and Song, J. 2008). This information is useful to estimate the damage and the losses. It can consider different types of assets such as buildings, bridges and lifeline (gas, water, electric facilities, etc.) (Kim, Y.S. 2007, Kim, Y., B. F. Spencer, and A.S. Elnashai. 2008).

With regards to buildings, it estimates structural and non-structural damage, economic losses and liquefaction damage. With regards to bridges, it computes damage, loss of functionality and repair cost analysis. For what concerns lifelines it calculates the network damage and the repair rate analysis. Finally, it computes socio-economic losses such as shelter needs, fiscal and business interruption.

1.1.2 IT-Details

EQvis is open source software. It is written in Java Language and using Eclipse RCP (J. McAffer, J.M. Lemieux, C. Aniszczczyk. 2010, E. Clayberg, D. Rubel. 2008). Eclipse RCP is a platform for building and deploying rich client applications. It includes Equinox, a component framework based on the OSGi standard, the ability to deploy native GUI applications to a variety of desktop operating systems, such as Windows, Linux and Mac OSX and an integrated update mechanism for deploying desktop applications from a central server. RCP made it possible to make EQvis modular and extensible. In fact, EQvis provides a framework to add new data and algorithms or update existing ones.

It also uses NCSA GIS Baseline that is a rich client application. This latter is composed by three main functions: data management (typing, ingestion, access, provenance tracking), visualization (support for 2D and 3D views, zoom, selection, highlighting), analysis execution (support for local multithreaded execution, visual dataflow system in development).

The extensions to NCSA GIS and RCP are all provided by plug-ins. The technologies used by EQvis are all open source software like geotools, vtk (Visualization Toolkit), Jasper Reports (for generating various kinds of outputs), JfreeChart and Ktable. EQvis is also planning/developing a ‘cyberinfrastructure/cyberenvironment’ that wants to provide universal access to the calculated results through ‘grid computing’, both for the calculation part and the
rendering part. By using as main transport SOAP/HTTP, the concept of repositories, and grid computing, the project is not only a client that makes risk analysis, but an entire platform that enables the user to use data from different places (data sources).

EQvis can easily integrate spatial information, data and visual information to perform seismic risk and analysis. It supports *.shp file that is really useful to visualize immediately input and output data. For what concerns output data it provides different formats of results such as *.dbf tables, .shp files and *.pdf files. The level of resolution depends on the size of the geounit that can be defined by the user. The geographical unit could be a regional unit, a provincial unit, a local unit and it could be an arbitrary polygon (regular or irregular).

Finally, EQvis has a user-friendly GUI that guides the user through the analyses. In the catalogue box, in the lower left corner, the databases are stored and the user can utilize this box to select default data or their own data that are saved herein. In the scenario box, in the upper left corner, the analyses that have been run can be selected and can be visualized on the right box of the GUI.

1.2 USING THE MANUAL

Many roads lead to Rome – this policy also applies to working with EQvis: graphics, tables and the Data catalogue are on an equal footing. To maintain the character of a reference book, the manual follows the order and the structure of the commands. The individual tables are described in detail column by column. Instead of presenting general Windows features, the manual rather gives practical hints and notes.

If you are new to the program, you should work through the introductory example step by step. Thereby, you will get familiar with the most important features of EQvis.
2 Installation

2.1 SYSTEM REQUIREMENTS

In order to use EQvis comfortably, we recommend the following system requirements:

- Operating system Windows XP Sp3 / Vista / 7
- CPU with 2 GHz
- 2 GB RAM
- DVD-ROM and 3.5" disk drive for installation, alternatively a network installation is possible
- 1 GB hard disk capacity, including approximately 500 MB for installation
- Graphic card with OpenGL acceleration and a resolution of 1024 x 768 pixels, onboard solutions and shared-memory-technologies are not recommended

When working on large systems, huge amounts of data will be produced. As soon as the main memory is not sufficient for taking the data, the hard drive will take over. This can slow down the computer significantly. Therefore, an increased memory will speed up the calculation much more than a faster processor. When selecting a motherboard, make sure that the main memory can be expanded.

2.2 INSTALLATION PROCESS

2.2.1 Installation from DVD

Once you located the folder setup_files, follow the instructions reported in Network Installation.

2.2.2 Network installation

EQvis

Create the following local folder, and place here all the setup files

C:\EQvis\setup_files

Install Oracle Java JRE by launching

C:\ EQvis\setup_files\jre-6u30-windows-i586-s.exe

Install the software to the folder C:\EQvis by running

C:\ EQvis\setup_files\EQvis-platform-setup.exe
OOFIMS Software

Install Matlab compiler runtime by launching
\texttt{C:\EQvis\setup\_files\MCRInstaller.exe}

Copy the folder OOFIMS from setup\_files to
\texttt{C:\EQvis}\n
MCDA

Copy the folder MCDA from setup\_files to
\texttt{C:\EQvis}\n
Fragility Function Manager

Launch
\texttt{C:\EQvis\setup\_files\Fragility\ Function\ Manager.msi}\n
Copy the folder Fragility Function Files to
\texttt{C:\EQvis}\n
If your default locale system does not specify a dot as decimal separator you will get a Warning Message at the start of the Fragility Function Manager. Please go to your windows system settings and select English\S USA\S as your locale system.

Database of Vienna

Copy the folder Data Vienna to
\texttt{C:\EQvis}\n
2.2.3 Installing Updates and New Modules

New versions of the suite will be delivered.
3  Introductory example

This chapter helps you to become familiar with the most important functions of EQvis by using a simple example. As there are so many different ways to achieve specific objectives it might make sense to use one or the other, always depending on the situation and the user’s preferences. This example aims to inspire you to discover the possibilities and options of EQvis on your own.

In this tutorial, EQvis will be used to determine the impact of an earthquake occurring in Vienna, mainly on its buildings. The tool will be used as a specific Emergency Manager would use it.

In the process it will be shown how to launch the application, load the GIS data, and generate earthquake hazard information based on the scenario of interest.

When the base information is loaded it’s possible to choose and display information for specific items of interest such as buildings, and load fragility information about these particular structures.

3.1  WELCOME SCREEN

When you start the software for the first time, you will be led to the welcome screen (Fig. 3.1).

![Fig. 3.1 Welcome screen](image)

To begin working, click the rightmost icon which will take you directly to the workbench (Fig. 3.2).
3.2 NEW SCENARIO

From the application’s menu bar, click File -> New Scenario

Alternatively, you can [click the New Scenario button] from the Scenario View’s tool bar.

Enter a name for your scenario, such as “Vienna”, and then optionally enter any descriptive information about the scenario in the large text box. Click next.
Introductory example

Fig. 3.4 Create scenario

Select Austria from the Country menu.

Fig. 3.5 Region of interest

Select Brigittenau district and select the box. A tick will appear next to the name. Then click next.
This wizard allows adding multiple regions of interest by selecting more boxes at the same time. Anyway this tutorial will only focus on Vienna.

From the dropdown menu, select **Empty Defaults**, then click **finish**.

This screen allows the selection of a default set. This will populate the analysis pages with default data where applicable (e.g. fragilities, fragility mapping, etc.). User Interface.
At this point, your scenario has been created. It will appear on the list of the Scenario View. A blank outline of Vienna will also appear in the Visualization View.

### 3.3 ADDING DATA TO THE SCENARIO

#### 3.3.1 Adding the City Plan of Vienna

Right click on Local Cache (bottom-left area).
Select Ingest Dataset.

![Ingest data](image)

**Fig. 3.9 Ingest data**

Select Shapefile and click next.

![File type](image)

**Fig. 3.10 File type**
Click **Browse** and go to the folder `C:\EQvis\Data Vienna\City Plan`

![Fig. 3.11 Browse](image)

Select the file **Strukturplan.shp** and Click next

![Fig. 3.12 Ingest a new Shapefile](image)

Select **Anonymous LineString-based geometry** and click **Next**.

![Fig. 3.13 Select data type](image)

Click **next**.

![Fig. 3.14 Set attributes mappings](image)
Click **next**.

**Fig. 3.15 Set extra field information**

Give “Vienna City Plan” as **name**, and **version** number 1.

**Fig. 3.16 Descriptive data**

**Wait** while ingesting. It does not take long.

**Fig. 3.17 Ingesting**
Double click **Vienna City Plan** (bottom left of the main window) to visualize a 2D render of the imported City Plan.

![Fig. 3.18 Working environment](image)

### 3.3.2 Adding the Building Dataset

**Importing**

Right click on **Local Cache** (bottom-left area).

Select **Ingest Dataset**.

![Fig. 3.19 Ingest Dataset](image)
Select **Shapefile** and click **next**.

Fig. 3.20 Select file type

Click **Browse** and go to the folder *C:\EQvis\Data Vienna\Buildings Vienna*.

Fig. 3.21 Browse
Click Open
Define the data set by selecting Building Inventory v4

Fig. 3.22 Select data type

Press next. This page allows the user to import the information present in the database. The association of the information contained in the imported database with preset labels allowing the mapping is here possible. In this case, nothing has to be changed.

Fig. 3.23 Set attribute mappings
Press next.

Fig. 3.24 Set extra field information
Introductory example

Give a descriptive name to the imported dataset, e.g. Buildings Vienna. Version number 1. Press finish.

At this stage of the tutorial the dataset have been imported in the local cache repository.

Display the data on the map

Double click Buildings Vienna in the Catalog (bottom left) in order to display the building set on the 2D map. In alternative, you can drag and drop it to the Visualization View.

Change layer style

From Scenario View, expand Vienna, then Mappable Data.

Right click on Change Layer Style
Introductory example

**Fig. 3.27 Change layer style**

In **Style Editor**, select the **Simple Style label**.
Adjust **color**, **size** and the other properties as required.
Once finished, confirm by pressing the **Apply style button** in the Style Editor's tab bar.

**Fig. 3.28 Adjusting parameters**

Navigate the 2D render. To zoom/pan/etc, use the controls at the top of the Visualization View.
Introductory example

Right click on **Mappable Data**, then **Render in 3D (VTK)**

This will bring up a Visualization View with the map, in a 3d rendered perspective.

Click the **Zoom to full extent** button in the toolbar to restore the original default view.

Navigate the 3D render
3.4 EXECUTE ANALYSIS

3.4.1 Analysis 1: Create Scenario Earthquake

A basic map of the area of interest has been created in the previous section “Adding Data to the Scenario”. The next step regards the setup and the run of an Analysis. It’s meant by Analysis any sort of calculation which leads to the generation of outcomes data. The first reported type of analysis is a deterministic earthquake map, based on a magnitude and epicentre input data.

Subsequently, a building damage analysis will be performed in order to proficiently estimate the occurring damages information on buildings. It will be based on both the created earthquake map, and on the imported building characterization (building inventory).

This section goes through all the procedure preliminary to the run.

Launch the Run Analysis Wizard by clicking the Execute Analysis button.

Expand Hazard and select Create Scenario Earthquake. Press finish.
Select the scenario [Vienna].

Fig. 3.33 Scenario selection

In the Analysis Wizard (simple or complete) click on the red button [Create Scenario Earthquake] in order to access the input form.

Fig. 3.34 Create scenario earthquake

Fig. 3.35 Create scenario earthquake (advanced)
Filling the **Required** inputs:

**Basic information**

Result Name:    EQ Vienna
Periodic Spectrum Method:  NEHRP Spectrum
Attenuation:    Campbell and Bozorgnia 2006 NGA

Fig. 3.36 Filling the form

**Earthquake location**

Magnitude:    6
Depth:    15 Km

Click **Select by clicking on the map** and specify the position of the Epicenter. It’s also possible to specify its exact location in the WGS 84 coordinate system. In this tutorial the epicenter will be located slightly south respect to the Vienna City Center.

**Raster Display Information**

Set the Display raster to **PGA**.

The other parameters define the area which will be displayed in the Visualization View. Leave them as **default**.
Advanced Parameters

Depending on the Attenuation Functions that you choose, different parameters can be selected. In this tutorial they will be left as Default.

The button execute should appear green, press it.

The earthquake should be very quickly generated and the name should appear in the scenario view. Close the analysis and observe the 2D map.
3.4.2 Analysis 2: Building Structural Damage

Building characterization: importing the fragility curves (Deliverable 7.1, 2009)

For this purpose, the fragility mapping file containing the fragility functions to associate to the buildings is assigned to the taxonomy contained in the building dataset shapefile.

Click on Window, then Show View. Expand the subfolder other. Double click on SynerGMapper.

![Fig. 3.39 Syner-G mapper](image)

Press Import Fragilities.

![Fig. 3.40 Import fragilities](image)
When the fragilities are imported, click **create mapping**. It may take a while, depending on the number of the specified buildings.

**Fig. 3.41 Create mapping**

**Ingest the fragilities**

Right click on **Local Cache** (bottom-left area).

Select **Ingest Dataset**.

**Fig. 3.42 Ingest the fragilities**
Select **Fragility** from the menu.

![Select file type: fragility](image)

*Fig. 3.43 Select file type: fragility*

Browse **C:\EQvis\Fragility Functions Files\OUT**, show the *.xml* files and choose **EQvis-Fragilities.xml**.

![Browse](image)

*Fig. 3.44 Browse*

Click **next**.

![Ingest a Fragility File](image)

*Fig. 3.45 Ingest a Fragility File*
Select Building Fragilities

Fig. 3.46 Select data type

Click next

Fig. 3.47 Set attributes mapping
Click next

Fig. 3.48 Set extra field information

Specify [EQvis Building Fragility], revision number [1]. Click finish.

Fig. 3.49 Descriptive data
Ingest the Fragility Mapping

Right click on Local Cache (bottom-left area).
Select Ingest Dataset.

![Fig. 3.50 Ingest Dataset](image)

Select Mapping from the menu

![Fig. 3.51 Select file type](image)

Select SynerG-Mapping.xml

![Fig. 3.52 Browse](image)
Click **next**.

**Fig. 3.53 Ingest a Fragility File**

Select **Fragility Mapping**

**Fig. 3.54 Select data type**
Fig. 3.55 Set attribute mappings
Fig. 3.56 Set extra field information
Specify EQvis Building Fragility Mapping, revision number 1. Click finish.

Fig. 3.57 Descriptive data

Execute the Damage Analysis
Analysis Wizard by clicking the Execute Analysis button on the toolbar. Expand SynerG Building and select Building Structural Damage analysis.

Fig. 3.58 Building Structural Damage

Specify the Scenario of interest: Vienna

Fig. 3.59 Select a scenario
Click on **Building Structural Damage** This page represents a graphical view of the damage analysis, including the required inputs. If the background of the Building Structural Damage button is red, the input data are missing.

Under the tab **required** of the form, you will need to provide several inputs. If the form is blank no datasets containing Fragilities, Expected Value or Fragility have been defined.

**Result name:** **Building Structural Damage**

![Fig. 3.60 Building Structural Damage](image)

To run this analysis, load datasets that contain the data: press the **Find Dataset** button. The window that appears contains a list box of all Fragilities Datasets that could be found in any of the connected data repositories.

Select **Buildings Vienna (local cache)** from the list, and click **Finish**.

![Fig. 3.61 Search for Dataset](image)
Introductory example

Select the Hazard **EQ Vienna**

![Fig. 3.62 Search for Dataset (EQ Vienna)]

Import the **Fragilities** and the **Fragility Mapping**

![Fig. 3.63 Search for Dataset (Building fragility)]
Import the **Fragility Mapping**.

![Fig. 3.64 Import fragility mapping](image)

Import the **Expected Values of Building Damage Ratios**.

![Fig. 3.65 Import damage ratios](image)
Click the **Execute** button to run the analysis.

![Fig. 3.66 Execute](image)

### 3.5 VIEW THE RESULTS

#### 3.5.1 Table view

First, the results will be viewed in a tabular grid, similar to excel.

In the **Scenario View**, right click on **Building Structural Damage** layer.

Select **Show Attribute Table**. The Table View appears in the bottom right of the application window. Moving or resizing operation is possible.

**Localization of the most damaged buildings:**

Scroll to the right edge of the table view, and click the column header labeled [MeanDamage (0-1)]. This is the column where the mean damage values of the buildings are shown. The table is now sorted by mean damage value.

Visualization of the buildings on the map of the area:

At this stage, the Building Damage layer shall be selected in the Scenario View; and the visualization should be the **2D visualization** view.

In the **Table View**, click on the first row with **mean damage** (Value of highest). The dots correspondent to the selected building changes its color in the Visualization View.

**Hold shift and click the last row** with desired mean damage value (e.g. 0.04). This will select all the buildings in between the specified range. The whole set of building will change color in the Visualization View.
3.5.2 3D Damage Bars

To facilitate the visualization of the damages across the area of interest, a 3-D bars view can be activated.

Right click the Building Damage layer in the Scenario View, and choose Ranged 3D Visualization.

During this step is possible to select the fields to be displayed on the map. In this case, the chance of each damage state will be represented. Select Insignificant, Moderate, Heavy, and Complete.
Click next. In the next screen, associate colors to the various fields. Choose a reasonable set of colors or use the defaults, then press finish.

Open the 3-D Visualization. The damage bars have been added for each building.

The size of each color in the bar represents the likelihood that the building will be in a certain damage state.
3.6 FILTERING DATA

Visualize buildings with less than 3 stories:
Right click the Building Damage layer, and select Filter. This brings up the filter dialog. In the Create a Filter dialog, double click the field no_stories. This adds the field to the query at the bottom of the page. Next, click the <= sign button. Finally, insert the number 3.
Press Finish.

**Get Unique Values button:** After the selection of a field, it is possible to get a list of the values that this field assumes in every line of the database by clicking the button *Get Unique Values*. When it is pressed, a query is sent to the database and the values appear in the matrix. They can be then inserted in the Filtering Equation.

Example: We want to display on the map just the buildings with 1,2 and 3 floors. Select the field *no_stories*, then press *Get Unique Values*. The query from the database gives us the information that *no_stories* can vary from 1 to 17. Then double click one value and complete the filtering equation.

---

3.7 **PRINTOUT REPORTS**

Once the user knows how to perform basic analysis on the available Dataset there is the possibility to generate reports automatically. These reports can be created and afterwards exported as a PDF.

Right click the name of your Scenario (Vienna) in the Scenario View, and select *Reports*. This will open the Report Selection View. It gives a list of reports that can be generated.
Introductory example

Next click on **Create a new custom report**. The selection of different items to insert in the Printout report is available.

Take the **table** and a screenshot of the **map**.

![Printout reports](image1)

**Fig. 3.72 Printout reports**

The embedding of the items in the report page is possible by dragging them, defining a priori their position and size.

The **mean damage** will be shown in the table as well as the **internal number of the building** and the probabilities of being in a defined **damage state**.

The generation of a PDF file is possible by clicking in any position of the page **Generate Report**.

![Generated Pdf](image2)

**Fig. 3.73 Generated Pdf**
Print the report or save it by using the buttons.

Use the small arrow next to the save button to select a different format for saving the report (such as PDF, HTML, etc)

3.8 LOG FILE

A session log file is available at the path C:\EQvis\workspace\.metadata. It gives detailed information regarding the working sessions.

Example:

| !SESSION 2012-10-08 14:11:36.711 -------------------------------
| |----------
| | eclipse.buildId=unknown
| | java.version=1.7.0_05
| | java.vendor=Oracle Corporation
| | BootLoader constants: OS=win32, ARCH=x86, WS=win32, NL=en_US
| | Command-line arguments: -os win32 -ws win32 -arch x86
| !ENTRY org.eclipse.jface 2 0 2012-10-08 14:11:43.403
| !MESSAGE Keybinding conflicts occurred. They may interfere with normal accelerator operation.
| !SUBENTRY 1 org.eclipse.jface 2 0 2012-10-08 14:11:43.403
| !MESSAGE A conflict occurred for CTRL+3:
| Binding(CTRL+3,
| ParameterizedCommand(Command(at.vce.maeviz.openMessage,Open Message Dialog,
| Category(at.vce.maeviz.category,Mail,null,true),
| ,true),null),
| org.eclipse.ui.defaultAcceleratorConfiguration,
| org.eclipse.ui.contexts.window,,,system)
| Binding(CTRL+3,
| ParameterizedCommand(Command(_mail.openMessage,Open Message Dialog,
| Category(_mail.category,Mail,null,true),
| ,true),null),
| org.eclipse.ui.defaultAcceleratorConfiguration,
| org.eclipse.ui.contexts.window,,,system)
| !ENTRY org.eclipse.jface 2 0 2012-10-08 14:11:43.403
4 User Interface

4.1 OVERVIEW

The user interface of EQvis is flexible and modular. Each module can be displayed in several positions of the main window, or can be either minimized to a Taskbar. In the Figure below, the Taskbar is shown only on the right side but it could appear also on the other side, depending on its position.

The EQvis workbench is built by a number of Views containing and displaying information about the specific modules. Each View is like a sub-window within main window, and can be minimized, maximized, or moved from the main window into its own window. These interactions are done by clicking the minimize/maximize icons in the view’s title bar, or by clicking and dragging on the view’s border or title bar.

![Fig. 4.1 Overview](image)

4.2 TERMINOLOGY

4.2.1 Scenario View

The Scenario View includes the list of the data pertinent to each scenario. They can be either mappable or not. Each scenario is listed as a top-level item in the view. It can be expanded by clicking the plus icon next to its name (+). All the details become then visible.

---

45
Inside each scenario, you can see a list of Mappable Data. These are the layers of data that are possible to visualize on the rendered map. The list of Scenario Data includes all non-renderable data for the scenario (e.g. tables).

The Scenario View is the platform where to perform the major operations on the scenarios such as adding an earthquake hazard or other data, running damage analyses, etc.

### 4.2.2 Visualization View

The Render Window is the area where the rendered maps appear. Each scenario can have its own rendered 2-D and 3-D map, where is possible to represent the results of your analyses. The control of the camera position is possible by using the mouse, or by clicking the view control buttons in the toolbar.

### 4.2.3 Data Catalogue

The Data Catalogue is the list of all the input data of the project. It is constituted either by preloaded data (such as libraries) or by data ingested in the cache during the ongoing session. It is organized by repositories which can represent local data or data stored on a remote server. Within each repository, the data are sorted by typology.

The data sorted in the Data Catalogue can be added to a Scenario and they can subsequently choose for being shown on the map. The data can be added to the Scenario by drag and drop or double click.

### 4.2.4 Style Editor View

The Style Editor is used to adjust the way in which a layer of data is displayed in the Visualization View. Style Editor is reachable by right clicking a Mappable Data layer in the Scenario View, and by selecting **Change Layer Style**. Several features are available such as colour, shape and opacity of the map layer. To apply the style changes, click the **Apply** button in the view's toolbar.

### 4.2.5 Table View

The Table View is used to display tabular data, generally the attributes of a set of inventory data or analysis results. The most common way to see this view is by right-clicking a Mappable Data layer in the Scenarios View and selecting **Show Attribute Table**.

### 4.2.6 Reports View

By right-click a scenario name in Scenarios View, and selecting **Reports** is possible to access the Reports View. From the Reports View it's possible to select a report to fill. The selected report will be generated, displayed and saved as PDF.
4.2.7 Fragility View

If you right-click a fragility dataset from the Catalog View, you can select View Fragility to access the Fragility View. The Fragility View shows a list of fragility types, that you can drill down into to select and view a particular fragility curve.

Choose the suitable literature model and then view it to by right-click. Select then View Fragility Set to view a graph of the fragility curve.
4.2.8 Status Bar

The status bar is useful to recognize whether EQvis is proceeding in multitasking with background operations. A label with the current operation will be shown in this position. Such operations could be, for instance: look for new repositories, load the cartography belonging to a determined scenario, etc.

4.3 SPECIAL FUNCTIONS

4.3.1 Managing the layers of the map

The layers can be sorted by means of these buttons. To optimize the render view, keep the layer with the contour plot of the simulated Earthquake as last item of the list. In this way, it will be the background for the other layers.

4.3.2 Improving the visualization

In the Style Editor of the EQ Vienna layer it is possible to select several options to improve and customize the 2-D or the 3-D renders. For example it is possible to vary the chromatic scale for the representation.

4.3.3 Saved Analysis Workflows

Under Mappable Data is present a special function called Saved Analysis Workflows. Under this name the software stores – and gives direct access – to the input forms of the launched analysis. This function is very practical for frequent updates and tests on the model.
4.3.4 Filtering

See the section 4.2 Filtering Data.
5 Using the OOFIMS – Plug-in

The usage of the OOFIMS software is generally described in Deliverable 2.1 (Deliverable 2.1, 2009). The software generally starts with the input file, which normally is filled within excel. This input procedure has been changed to the EQvis platform. The input can be given directly in the platform now. There is still the option to manipulate the input file directly, it is located at C:\EQvis\OOFIMS/oofims_in.xls.

5.1 USING OOFIMS: EXAMPLE DATASET IN VIENNA

5.1.1 Download/Unzip the data

In order to use the OOFIMS software correctly, the user has to unzip the data-files provided in the OOFIMS_Data_Example.zip file. It contains all the necessary data to complete this tutorial. The tutorial will explain the main functions on behalf of the Vienna test case on buildings. When EQvis has been installed successfully the first calculations with the OOFIMS – Plug-on can be started.

5.1.2 Ingesting the datasets

The first things to be done are ingesting the needed data files into the platform. For this Tutorial it is sufficient to ingest 4 data-files:

1. Seismic Shapefile: Right-click on the Local Cache button and choose “Ingest dataset”. Select Shapefile as the dataset and click “Next”. Choose the Seismic Shapefile for OOFIMS that you have downloaded together with this Tutorial and click next. The data type you have to set to “Seismic Shapefile”, click “Next”. Click Next two times until you reach the Descriptive Data window. Enter the name “Seismic Shape Vienna_OOFIMS” and give it the number 1, then click Finish. The shapefile is now ingested.

2. Sub City Districts: Right-click on the Local Cache button and choose “Ingest dataset”. Select Shapefile as the dataset and click “Next”. Choose the Sub City Districts file that you have downloaded together with this Tutorial and click next. The data type you have to set to “Building Census”, click “Next”. Click Next two times until you reach the Descriptive Data window. Enter the name “Sub City Districts_Vienna” and give it the number 1, then click Finish. The shapefile is now ingested.

3. Land Use Plan: Right-click on the Local Cache button and choose “Ingest dataset”. Select Shapefile as the dataset and click “Next”. Choose the Land Use Plan for Vienna that you have downloaded together with this Tutorial and click next. The data type you have to set to “Land Use Plan”, click “Next”. Click Next two times until you reach the Descriptive Data window. Enter the name “Land Use Plan_Vienna” and give it the number 1, then click Finish. The shapefile is now ingested.

4. Building Census: Right-click on the Local Cache button and choose “Ingest dataset”. Select Shapefile as the dataset and click “Next”. Choose the Building Census file for
Using the OOFIMS – Plug-in

Vienna that you have downloaded together with this Tutorial and click next. The data type you have to set to “Building Census”, click “Next”. Click Next two times until you reach the Descriptive Data window. Enter the name “Building Census_Vienna” and give it the number 1, then click Finish. The shapefile is now ingested.

5.1.3 Starting the Analysis

To start the analysis, click the execute analysis button in the left window. If you do not have selected a scenario yet, the user is asked to select the scenario. This is only the case if more than one scenario has been created already. Now you should be in the Execute Analysis window. Click on the “Syner-G Oofims” Button and you should see 4 different options. The first thing to do is to create the input file. Click on “Create Oofims Input” and then “Finish”.

5.1.4 The OOFIMS Input mask

Now you are at the starting page of the OOFIMS Input. In principle it is divided into 5 sections: “Analysis”, “Seismic”, “Buildings”, “Water Supply System” and “Road Network”. The usage of these sections is described in Deliverable 2.1. In general, the use of these input masks is very simple. In order to complete the Tutorial you may enter the following inputs:

Analysis

As the simulation method you should choose “mcs”. Various new parameters show up, but you can leave them in default.(10, 10, 0.02).

Seismic

At first you have to specify the seismic shape file. Now you can use the file that you imported earlier. Click on Search and take the “Seismic Shape Vienna_OOFIMS” file.

In the following table you may find the input you should input:
### Table 5.1 Input values for the OOFIMS Tutorial – “Analysis”

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ground Motion Prediction Equation</td>
<td>AkkarBommer</td>
</tr>
<tr>
<td>Primary IM</td>
<td>PGA</td>
</tr>
<tr>
<td>Landslide susceptibility map name</td>
<td>None</td>
</tr>
<tr>
<td>VS30 map name</td>
<td>None</td>
</tr>
<tr>
<td>Liquefaction susceptibility map name</td>
<td>None</td>
</tr>
<tr>
<td>Amplification method</td>
<td>Gmpe</td>
</tr>
<tr>
<td>Source model</td>
<td>areaFault</td>
</tr>
<tr>
<td>Number of step – Longitude</td>
<td>20</td>
</tr>
<tr>
<td>Number of step – Latitude</td>
<td>20</td>
</tr>
</tbody>
</table>

### Table 5.2 Input values for the OOFIMS Tutorial – “Buildings”

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Study Region-Num.Step Longitude</td>
<td>1</td>
</tr>
<tr>
<td>Study Region-Num.Step Latitude</td>
<td>1</td>
</tr>
<tr>
<td># of refinements</td>
<td>4</td>
</tr>
<tr>
<td>Good weather – fully usable</td>
<td>1</td>
</tr>
<tr>
<td>Good weather – partially usable</td>
<td>0.7</td>
</tr>
<tr>
<td>Bad weather – fully usable</td>
<td>0.8</td>
</tr>
<tr>
<td>Bad weather – partially usable</td>
<td>0.5</td>
</tr>
</tbody>
</table>

### Buildings

In the “Buildings” section you have to define also the shapefiles that you have imported earlier (Sub City Districts, Land Use Plan and Buildings Census).

When all the parameters are correct you may click on “Execute”. Now the input excel file is written and stored in C:\EQvis\OOFIMS.

#### 5.1.5 Running the analysis

To run the analysis, you have to open “Window”, then “Show View” -> Other. Then Choose the “OOFIMS Runner”.

On the screen you should now be able to see the Console and a button called “run module”. Click on that button and the analysis will start. Depending on the amount of data that you have specified, the computing time varies. Once the simulation is finished, the console reads: “done” and an output file is created in a new folder in :  C:\EQvis\OOFIMS\output.

#### 5.1.6 Read the output of OOFIMS

If you want to display the results of the simulation you have to execute a new analysis in the Syner-G Oofims field called “Read Oofims Output”. Here you have to specify a name for the result, which will then appear in the Scenario View on the left side. You have two options now. You can either display a specific file of the analysis by clicking manually selecting file,
or you can specify the number of the run you want to display. For the tutorial write “OOFIMS Output - raw”, click “Manually select files” and then press Execute.

Now the output of the OOFIMS plug-in is read but the structure of this output does not fit to the original geometry of the input files. The output is now generated in rectangular cells.

5.1.7 Creating the Intersections

In order to get the intersection points of these cells with the original you have to click on the Execute Analysis button and choose “Create Intersections” in the Syner-G OOFIMS field. Specify the result name (Intersections_Vienna), and provide the 2 datasets that are required: The “OOFIMS Output – raw” file and the original file with the Sub City Districts (“Sub City Districts_Vienna”).

5.1.8 Creating the MCDA Sub City Districts file

In order to be able to use the dataset one more analysis has to be performed. “Create MCDA SCDs” is now filling the data into certain format which can be used in the MCDA Plug-in. There are mainly 3 datasets to be filled. “Oofims3 Cells” is the name of the “Create Intersections” file (Intersections_Vienna) and “Sub City Districts” is again the Sub City Districts file for Vienna (“Sub City Districts_Vienna”). The results of the OOFIMS run can now be specified or EQvis takes the last run of the OOFIMS – Runner. If you want to specify the file yourself you have to check the box “Manually select “SimulationResults”. Note that you have to specify the right SimulationResult.xls. Set the result name to “MCDA_SCDs_Vienna”. This file contains now all the information in the correct (original) format. This data can be viewed and filtered again.
6 Using the MCDA – Plug-in

6.1 INTRODUCTION

6.1.1 OVERVIEW of MCDA SOFTWARE

MCDA is a Java-based software for multiple criteria decision. In decision making problem the decision maker has some alternatives and some criteria on which the decision is based. In MCDA the problem is structured hierarchically to form a value tree. In this value tree each criterium is divided to its subcriteria, which are weighted by their importance to decision maker (On the lowest level criteria the alternatives are weighted). The total weights of the alternatives are calculated from these local weights.

The local weights of criteria and alternatives are given directly or by using some sophisticated weighting method. MCDA supports an interactive visual weighting method, where the user can change and manipulate the existing weights and interactively investigate the changes upon the total ranking outcome in the analysis.

As a result of the decision making problem MCDA gives the total weights of the alternatives. These weights are shown by bar graphs and bars which can be divided to segments by contribution of each criterion. There is also a possibility to run a sensitivity analysis, which gives more information about the sensitivity of the results.

Decision support for emergency management involves resolving conflicting objectives, setting priorities and building census for the various perspectives of the many stakeholder groups.

The implementation of the shelter model has been tested and validated with the use of the MCDA software, which was found to be a flexible and practical analytical platform for duplicating methodology. The software supports performing sensitivity analyses, which can be used to interactively demonstrate variability of the results to different indicators. It also enables an evaluation of the stability of the methodology to variability of the input data. The advantage of using such a tool is that it integrates the outputs of different physical risk models and that other indicators that may have previously not been available or simply overlooked in a previous analysis can be integrated into the framework interactively to obtain a new evaluation of shelter needs.

The software was developed at KIT starting September 2010 to present by Susan Vaziri Elahi and Tim Mueller at the Institute for Nuclear and Energy Technologies (IKET), KIT.

6.1.2 Overview of MCDA Framework

MAVT (Multi-Attribute Value Theory) is a MCDA framework that provides methods to structure and analyse problems by means of attribute trees and to elicit the relative importance of the criteria in such a tree.

Several key phases of MCDM (resp. of MAVT) are distinguished:
Problem structuring can be described as the process of appropriately formulating rather than solving a problem;

- Better understanding of the problem and the values affecting a decision;
- Basis for further analyses and common language;
- In addition to identifying and specifying objectives (criteria) and attributes as well as decision alternatives, the aim of problem structuring is the hierarchical modelling of the criteria;
- Top-down approach: Strategic approach, starting with the determination of the most general objective which is then successively divided into sub-objectives and – on the lowest level – measurable attributes
- Bottom-up approach: Tactical approach, starting with the identification of measurable attributes in which the performance of the alternatives differs which are then combined and structured into higher level objectives

6.1.3 Definition of Terms used in MCDA

**Alternatives**: possible countermeasure options that might be applicable for our problem

**Criteria/Attribute**: Means that are important for the decision making process such as consequences/deaths, costs, resources but also acceptance

**Attribute trees**: tree structure of criteria/attributes that are relevant for the decision making process; result of problem structuring

**Preferences/Weights**: which of the above mentioned criteria/attributes is more important for my decision making than others.

**Final goal**: The objective of my process (e.g. reduction of the amount of contaminated milk above a certain level)

6.2 INSTALLING THE MCDA TOOL

6.2.1 Basic requirements for installing MCDA Tool

In order to use MCDA comfortably, we recommend the following system requirements:

- Operating system Windows XP Sp3 / Vista / 7
- CPU with 2 GHz
- 2 GB RAM
- 200 MB hard disk capacity
- Graphic card with OpenGL acceleration and a resolution of 1024 x 768 pixels, onboard solutions and shared-memory-technologies are sufficient
When working on large systems, huge amounts of data will be produced. As soon as the main memory is not sufficient for taking the data, the hard drive will take over.

6.2.2 Quick step by step guide for installing MCDA

Installing the MCDA Tool in EQvis is actually a very easy task. The provided folder called “MCDA” has to be copied to the right folder. Copy the “MCDA” folder to C:\EQvis\. If you want to start MCDA independently of the EQvis platform, you have to double-click the MCDA-GUI.jar file. MCDA will open. If you want to start the MCDA tool in EQvis, there are two options, either starting MCDA with the symbol in the left upper side of the platform, or executing analyses before starting MCDA. The first option is more or less the same as starting MCDA directly.

6.2.3 Links to OOFIMS outputs (i.e. visualization of simulations)

OOFIMS produced different outputs in different data files. There are some matlab files, excel files or even figures. All these different files are put together in a GIS shapefile. This is realised in different analyses that the user can perform within the platform. There is a logic behind all these steps which will be shown in this chapter.

6.2.3.1 Reading the OOFIMS Outputs

This analysis reads the outputs from OOFIMS and stores them internally. The user has to provide the run-number which shall be displayed within the platform, or manually select the files (The user has to provide a folder).

Fig. 6.1 The Analysis “Read OOFIMS Output” (left), sample Dataset (right)
6.2.3.2 Create Intersections

This analysis takes the file from the last analysis and intersects the results with the original Sub-City-Districts file. The output of OOFIMS is characterised through cells which can be defined prior to the calculations done in OOFIMS. Depending on the size of the cells the results may vary.

![Diagram of Create Intersections](image)

**Fig. 6.2 The Analysis “Create Intersections” (left), sample Dataset (right)**

6.2.3.2.1 Explanation about the calculations

In this small chapter the calculations for the intersections are explained. In Fig. 6.3 one can see a typical case of a cell that is produced by OOFIMS. This cell contains information about building damage, displaced people, etc. This cell does not coincide with the format of the Sub City Districts. It is a completely new grid that is produced. The information has to be transformed into the right geometries, in this case the Building Cell structure, which was the original input in OOFIMS. To do this, the cells of the OOFIMS output are intersected with the original files geometrically. In Fig. 6.3 one can see a cell (brown) and one line of an original building cell (green area). The calculation is now done via the intersection. The area of the cell is being calculated and the percentage in relation to the whole area is calculated. This percentage is now added to the respective Building Cell it belongs to. This calculation is done for each output cell. In the end for each cell the user gets a transformation of the information into the original Building Cell structure.

This procedure is again performed in the next step of the analysis “Create MCDA SCDS”. The calculated Building Cells now represent the cells and they are being intersected with the original file for Sub City Districts.
6.2.3.2.2 Create MCDA SCDS

This analysis does not perform new computations. It searches in the datasets for the necessary information that is needed as an input for the MCDA software. This analysis produces a shapefile which can be visualised separately and can be used as an input for the MCDA software.

As previously explained the intersection is realised in the same way as the intersection from cells to Building Cells.

6.2.4 Using the input interface in the SYNER-G Platform to launch MCDA

To get to the MCDA Plug-in with the data produced in OOFIMS you may open the “Execute Analysis” window and choose Syner-G MCDA and then “MCDA Input”. This Analysis again divides in the 2 known categories: Required and Optional.
The next field in the required mask is the “Indicators” field. It divides in 4 categories and sets the initial values for each of the categories. Once you have inserted all the necessary information, the Execute button appears green and the analysis can be started. At the end of this analysis the data is automatically loaded in the MCDA input file and MCDA is started.

6.2.4.1 MCDA Input

This analysis takes the shapefile from the previous task together with some additional information and starts the MCDA software with the requested input. The additional information can be Urban Audit Data, the required indicators and optional information like Shelter Accessibility and various different transformation functions.

![Fig. 6.5 The Analysis “MCDA Input” (left), starting screen of MCDA (right)](image)

6.3 MCDA SOFTWARE TUTORIAL

6.3.1 SHELTER NEEDS MODEL

The integrated shelter needs model developed here is implemented based on the principles of multi-criteria decision theory (MCDA) framework which allows the bringing together of parameters influencing the physical inhabitability of buildings, with social vulnerability (and coping capacity) factors of the at-risk population to determine as well as external factors to determine the desirability to evacuate and seek public shelter. As shown in Fig. 6.6, the multi-criteria framework can be described schematically as composed of the two main criteria: overall population at risk of being displaced after an earthquake (DPI) and the proportion of this population likely to seek public shelter (SSI). The Displaced Persons Index (DPI) is given as occupants in Building Habitability Index (BHI) amplified by external and internal factors related to desirability to evacuate according to Equation 6. (For more on the shelter needs methodology please refer to the SYNER-G Reference Report 5).

\[ DPI = BHI(1 + DE) \]  (6.1)
Using the MCDA – Plug-in

Subsequently, the total demand for public shelter for a particular location (i.e., city district) can be described as a product of the population at risk of being displaced (D1, D2 and D3) to the population likely to seek public shelter (D4). This can be expressed by Eq. (6.1):

\[ SNI = DPI \cdot SSI \]  

where, SSI is derived from a weighted index related to lack of access of resources indicators in a community or neighborhood as shown in Reference Report #5, and DPI is given as occupants in uninhabitable buildings amplified by external and internal factors related to desirability to evacuate according to Eq. (6.2)

6.3.2 Steps in developing the model

The process of developing the Shelter Needs Index consists of five main steps which should be passed in an iterative manner.

1. **Theoretical Concept**: Within the indicator development process the development of the theoretical indicator framework (step 1) contains the specification of the various dimensions to be covered, i.e. the sub-systems of the physical risk and social vulnerability explained in depth in Reference Report #5.

2. **Indicator Selection**: The second step is defining and populating the indicators for each sub-system according to the framework identified in step 1, and collection of the requisite data. In order to guarantee the quality of the composite indicator framework, the single sub-indicators should meet some quality standards. For example, indicators used should be reliable, accessible, reproducible, interpretable and accurate.

3. **Normalization**: Before aggregating the values of the sub-indicators into an overall composite indicator value, the sub-indicator values must be normalized (step 3). This is necessary because most of the sub-indicators have different units and cannot be combined into the indicator framework in their original values.
4. **Aggregation**: In the *fourth step*, the sub-indicators are combined together as a weighted sum which results in the form of one single aggregated index value, UDRI, and several sub-levels.

5. **Sensitivity Analysis**: Due to the difficulty in operationalizing all dimensions of vulnerability (i.e., some dimensions cannot be measured) and the high amount of underlying data, the results might also be affected by different sources of uncertainty. This applies also to the intra-model uncertainties associated with the weighting process and the implementation of transformation functions, but also the uncertainties contained within the input-data which can be substantial. Therefore, in order to analyse the robustness of the methodology, a sensitivity analysis which demonstrates variability of the results should be conducted as a *final step*.

### 6.3.3 Implementing the model in MCDA software

#### 6.3.3.1 Theoretical concept - Creating the Decision Tree

Using the hierarchical "Tree View" in the MCDA software, under the View -> Frames Menu in the GUI, the Shelter Needs Index (SNI) framework can be implemented by sequentially defining the following options in the decision tree (Fig. 6.7):

1. **Define Goal**: In this example, Shelter Needs Index (SNI) is defined as the main goal.
2. **Add Alternatives to SNI**: In this example case three Alternatives were added (SCD1, SCD2 and SCD3). These are the sub-city districts in the example for which the shelter needs is computed.
3. **Add Criterion to Alternatives**: The two sub criterion as can be seen in the figure are added as Displaced Persons Index (DPI) and Shelter Seeking Index (SSI).
4. **Add Sub-criterion to DPI**: This is the Building Habitability Index (BHI) and the Desirability to Evacuate sub-criterion.
5. **Add Sub-criterion to “Desirability to Evacuate” sub-criterion**: Here we add four indicators describing this sub-criterion: 1) Ratio of Lone Parent Households with Children; 2) Proportion of Children (0-4); 3) Proportion of Elderly (65 and over); 4) Ratio of sub-standard dwellings lacking basic amenities. These are the indicators from the Urban Audit which describe the Desire to Evacuate sub-criterion (more on the choice for the selection of indicators can be found in Reference Report #5).
6. **Add Sub-criterion to SSI**: This is the Accessibility Index (AI) and the Desirability to seek public shelter sub-criterion.
7. **Add Sub-criterion to “Desirability to seek public shelter” sub-criterion**: Here we add four indicators describing this sub-criterion: 1) Migrants from low HDI countries; 2) Ratio of population under Poverty Line; 3) Ratio of low education population (below ISCED level 2); 4) Unemployment Ratio. These are the indicators from the Urban Audit which describe the desire to seek public shelter sub-criterion (more on the choice for the selection of indicators can be found in Reference Report 5).
6.3.3.2 Populating the Data Matrix

Once the aggregated decision tree has been constructed in MCDA using the “Tree View” option (see Fig. 6.7), the values for each of the Alternatives and Measures can be populated using the “Edit Data” feature from the “Data” Menu in the GUI. This brings up a hierarchical table which can be expanded fully and values for all of the indicators (measures) can be taken over from the Urban Audit or from input models, such as the OOFIMS model to compute BHI or the Accessibility model to compute the Accessibility Index (AI).

In this example, some fictional values are used as the indicators for each of the three different Sub City Districts (SCDs), and are entered into the Table (Fig. 6.8).
6.3.3.3 Normalization

A normalization converts a measure's levels into common units called utility. MCDA uses different types of transformation formulas (simple linear, adjusted simple linear, peak linear, quadratic, simple quadratic, adjusted simple quadratic, piecewise linear). Essentially, linear transformation functions straight lines and quadratic transformation functions are smooth curves. They can be either decreasing or increasing (depending on whether an indicator describes a vulnerability or a coping capacity). The only restrictions are that the least preferred Level of a measure must have a Utility (normalized value) of 0.0 and the most preferred level must have a SUF Utility of 1.0.

As can be seen in Fig. 6.9, the values of the actual indicators are entered in their “raw form” which in turn are normalized and presented in the column indicating the transformed variables. By default a “Adjusted Linear Normalization” is used to transform the data. To change the transformation values the normalized values can be edited by clicking into a cell of the table. Right-clicking brings up a context popup. By choosing, “Criterion value function” the Normalization frame of the clicked criterion be activated where a normalization function can be defined.

![Fig. 6.9 The Criterion Value Function Dialogue Box which can be used to define the shape of the normalization curve of each selected criteria measure](image)
6.3.3.4 Aggregation of Decision Criteria

After the decision tree has been developed, the aggregation functions between the various criterion and sub-criterion have to be defined. A criterion’s members are said to interact when a high utility on any one member results in a high utility for the goal or when a low utility on any one member results in a low overall utility for the goal. MCDA models interactions by defining a “weighted sum”, “weighted product” or by allowing the user to enter an “expression” under the Aggregator option for each of the criteria. The aggregator option can be accessed by right clicking on each of the criterion or sub-criterion from the decision tree (Fig. 6.10). The following aggregators are defined for the Shelter Needs model according to the equations presented in section 6.4.1:

1. SNI: use the expression $SNI = \text{Weighted Product}$ (to produce the equation $SNI = SSI \times DPI$)
2. DPI: use the expression $DPI = \text{weighted}_BHI \times (1 + \text{weighted}_\text{Criterion_Desirability_to_Evacuate})$
3. SSI: use the expression $SSI = \text{weighted}_AI \times (1 + \text{weighted}_\text{Criterion_Desirability_to_See_Public_Shelter})$
4. Desirability to Evacuate (DE): use weighted sum aggregator
5. Desirability to Seek Public Shelter (SPS): use weighted sum aggregator

Fig. 6.10 The criteria aggregator dialogue box, which can be used to define the aggregation relationship for each criteria as "weighted sum", "weighted product" or a "mathematical expression/formula" defined by the user

6.3.3.5 Assigning Weights

Using the Data -> Edit Importance menu from the GUI, the weights dialogue can be activated. Weights are a loose term for the scaling constants associated with the active members within a criterion or sub-criterion. Weights are not important by themselves, but do provide an indication of the relative indicators’ relative importances, given their ranges. All of MCDA weight computations are based on the ranges defined in the weight dialog boxes.
The weights for each criterion are defined by a Multi-Utility Function (MUF). A Multi-measure Utility Function (MUF) is the formula MCDA software uses to compute the utility (common units score) for an alternative on a goal based on the alternative's utilities on the goal's members. The formula combines the alternative's utilities on the goal's members using a weighted average, weighted product or other expressions as entered by the user in the previous step.

It should be noted that the weights for each MUF add to 100%. The values selected for the weights are shown in Fig. 6.11, but can be changed interactively by the user for each MUF.

![Image of Fig. 6.11](image)

**Fig. 6.11** The interactive importance/weight dialogue box which can be used to change the weights of each of the criteria measures on the fly

### 6.3.4 Displaying Results

#### 6.3.4.1 Stacked Bar Chart

Ranks your alternatives with a stacked bar chart showing the contribution of the measures and/or goals to the results by selecting Plots -> Stacked Bar for Alternatives Menu. Each alternative's bar is made up of sub-bars that show the contribution from individual measures or goals. Alternatives with the minimum utility on a member will have no sub-bar for that member. Alternatives with the best utility on a member will have the longest sub-bar for the member. Members with more weight will have longer sub-bars. As shown in Fig. 6.12, to display the stacked bar rankings for the main goal (SNI), the “up to tier 1” option has to be selected. The “sort” option will then rank the highest to lowest SCD from left to right. It can be seen in this example that SCD 1 has the highest shelter needs, as both the contribution of Displaced Persons (DPI) and Shelter Seeking population (SSI) are the highest in this SCD. By selecting “up to tier 1” and “up to tier 2” option the sub-criteria at each tier will be added to the stacked bar chart (Fig. 6.12 and Fig. 6.13, respectively).
6.3.4.2 Criteria Importance

The weights for each of the criteria and the indicators can be changed interactively by selecting the Data -> Edit Importance menu to bring up the weights dialogue box. Furthermore, by selecting Plots -> Criteria Importance from the drop down menu, the importance level (weights) of each of the criteria, sub criteria and measures describing these can be viewed for all the different tiers of the analysis in a cob-web chart (Fig. 6.14). The importance of each of the criteria for the different alternatives can also be summarized by selecting Plots -> Pie Alternatives from the menu (Fig. 6.15)
6.3.4.3 Analyzing Stability of Analysis

By selecting Plots -> Display Solutions Stability from the Menu in the GUI, the effect of changing a measure's or criteria's overall weight can be seen (Fig. 6.16). When you select this option, MCDA displays a dialog box where you choose a criterion to analyze (e.g., DPI).
You can also choose a normalized solution in the options. The options are to sort the alternatives in the key by Name, by their overall ranking or by their ranking on the selected criterion. The alternative lines are colored in the order they are shown in the key. As such, MCDA draws a graph showing the effect of varying the measure's (or goal's) percentage of the overall weight from 0 to 100 percent. The graph's horizontal axis is the criterion's percentage of the overall weight. At 100 percent weight the measure is the only concern and an alternative's overall ranking will match its ranking on the measure. At zero percent, the measure is not a concern and its weight is distributed among the other measures. A vertical line represents the measure's percentage of the overall weight in the active preference set.

**Fig. 6.16 A sensitivity graph in MCDA showing the sensitivity of the alternative's ranking to the weights of DPI**
References

MAEviz software tool, http://mae.cee.illinois.edu/software_and_tools/maeviz.html
D. Schäfer, M. Pietsch, H. Wenzel. EQvis: A consequence based risk management software tool. SEMC Conference, Cape Town, 2013
Mid-America Earthquake Center. 2009. Impact of New Madrid Seismic Zone Earthquakes on the Central USA. MAE Center Report No. 09-03
Abstract

This report should work as a first guideline for using the EQvis – Platform. It shows the user the most used features of the package and guides the user through a tutorial which explains many of the features in EQvis. This document can only serve as a starting point. Many of the analyses need special datasets that have to be prepared first. This Tutorial comes with a sample dataset for the city of Vienna with which the user can get through the analyses produced in this project. More information together with the open source software code and the dataset for this Tutorial can be downloaded at the Syner-G website: www.syner-g.eu.
As the Commission’s in-house science service, the Joint Research Centre’s mission is to provide EU policies with independent, evidence-based scientific and technical support throughout the whole policy cycle.

Working in close cooperation with policy Directorates-General, the JRC addresses key societal challenges while stimulating innovation through developing new standards, methods and tools, and sharing and transferring its know-how to the Member States and international community.

Key policy areas include: environment and climate change; energy and transport; agriculture and food security; health and consumer protection; information society and digital agenda; safety and security including nuclear; all supported through a cross-cutting and multi-disciplinary approach.